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Thank you for purchasing 78K0 Series system simulator SM78K0 V2.52.  

This document explains the modifications from SM78K0 V2.40 to V2.52, cautions, and usage restrictions.  

Be sure to read this document before using SM78K0 V2.52. 

 
1. USER’S MANUAL  
 
The following user’s manual is available for this version as a PDF file only. 

• SM78K Series V2.52 System Simulator - Operation (document number: U16768E) 

 
2.  SUPPORTED TOOLS 
 
Use the following tool versions when used in combination with SM78K0 V2.52. 

• Assembler:   RA78K0 V3.60 or later 

• Compiler:   CC78K0 V3.50 or later 

• Project manager:  PM plus V5.10 or later 

 

3.  ITEMS REVISED FROM V2.40 TO V2.52 
 
This section explains the changes from V2.40 to V2.52.   

 
3.1  Added or Modified Functions 
 

• Windows XP is now supported. Windows 95 is no longer supported in V2.52 and later. 

• PM plus is now supported.  Project Manager is no longer supported. 

• The right-click menu has been modified. 

• A variable, octadecimal, hexadecimal, and negative number can now be specified as a subscript of 

arrays in windows displaying variables such as the Watch window. 

    Example) Variable: var[i], octadecimal: var[010], hexadecimal: var[0xab], negative number: var[-6] 

• The display file save/restore function has been separated into a display file and an environment file. 

• The color of the frame at the start of a function in the Trace window has been changed to make it easier 

to see. 

• The Help menu has been changed to an HTML-format help. 
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3.2  List of Handling of Restrictions (Debugger Block) 
 

Since the numbers assigned to the restrictions have not been changed, the restriction numbers shown 

below are not consecutive. 
 

Version No. Bugs and Changes/Additions to Specifications 
V2.40 V2.52 

2 Wrong error message is output in Symbol to Address dialog box × √ 
5 Maximum display address of Assemble window is not displayed × √* 
7 Members of pointers cannot be displayed in Watch window × √* 
8 Bug when mixed display is set in Source window × √* 

17 320th and subsequent characters are not displayed × √* 
21 Breakpoint cannot be set to the same address as the defined symbol value × √ 
24 Display may become illegible if right/left arrow key is used to scroll area × √* 
26 Debugger (simulator) is abnormally terminated × √* 
29 Bug in search file function in Source Search dialog box × − 
30 Display in Watch and Local window is incorrect when an array is declared as a 

function argument 
× √ 

31 Program cannot be edited when Source window is in mixed-display mode × √* 
32 Files with the same name cannot be displayed in Source window × √* 
33 Dummy RRM is disabled in SFR area × √ 
39 Asterisk (*) indicating break-settable line is not displayed in Source window × √ 
47 Bug in saving a display file in Watch window × √ 

×: Applicable, √: Not applicable, √*: Included in user’s manual, −: Not relevant 

 
 
3.3  Details of Handling of Restrictions (Debugger Block) 

 

No.2  Wrong error message is output in Symbol to Address dialog box 

[Description]  

If an SFR bit is specified in the Symbol to Address dialog box, an error occurs but the wrong error 

message “F002(f), Illegal expression” is output. 

[Action]  

This bug has been corrected in V2.52. 

 

No.5  Maximum display address of Assemble window is not displayed 

[Description]  

The maximum display address “0xFFFF” of the Assemble window is not displayed. 

[Action]  

This item has been included in the SM78K Series V2.52 user’s manual as a caution on use. 
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No.7  Members of pointers cannot be displayed in Watch window 

[Description]  

Even if the members of pointers such as structures and arrays are displayed and saved to the project 

file, the members are not displayed in the Watch window when the project file is loaded.  At this time, 

the display radix of each member is not displayed. 

[Action]  

This item has been included in the SM78K Series V2.52 user’s manual as a caution on use. 

 

No.8  Bug when mixed display is set in Source window 

[Description]  

If mixed display is set in the Source window and the cursor is scrolled downward (in the direction of the 

end of the file), a redundant scroll occurs.  As a result, the displayed line numbers may not be 

sequential.  While the end of the source is displayed, the last part cannot be displayed unless scroll is 

used during mixed display. 

[Action]  

This item has been included in the SM78K Series V2.52 user’s manual as a caution on use. 

 
No.17  320th and subsequent characters are not displayed 

[Description] 

The number of characters that can be input in a line in the Source window, Assemble window, or 

watch-related windows is up to 319 .  The 320th and subsequent characters are not displayed.   

[Action] 

This item has been included in the SM78K Series V2.52 user’s manual as a caution on use. 

 

No.21  Breakpoint cannot be set to the same address as the defined symbol value  

[Description] 

If valid EQU symbols are defined only in an assembler source file, a breakpoint cannot be set to the 

same address as the defined symbol value.   

[Action] 

This bug has been corrected in V2.52. 

 

No.24 Display may become illegible if right/left arrow key is used to scroll area 

[Description] 

When there is insufficient space in the data value display/setting area (in the SFR or Register window, 

etc.), if the right/left arrow key is used to scroll the area, the display in the data value display/setting 

area may become illegible.   

[Action] 

This item has been included in the SM78K Series V2.52 user’s manual as a caution on use. 
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No.26  Debugger (simulator) is abnormally terminated 

[Description] 

In the debugger (simulator) specifications, if there is a script file with the same name as the load 

module to be downloaded and with the extension “.tcl”, the script is automatically executed immediately 

before downloading.  If the program to download the load module is written in a script, the download 

loops and the debugger (simulator) is abnormally terminated.   

[Action] 

This item has been included in the SM78K Series V2.52 user’s manual as a caution on use. 

 

No.29  Bug in search file function in Source Search dialog box 

[Description] 

The search file function cannot be used in the Source Search dialog box. 

[Action] 

This function has been removed in V2.52. 

 

No.30 Display in Watch and Local window is incorrect when an array is declared as a function argument  

[Description] 

When an attempt is made to reference the contents of an array from the Watch or Local window when 

an array is declared as a function argument, the incorrect memory location is displayed. 

[Action] 

This bug has been corrected in V2.52. 

 

No.31 Program cannot be edited when Source window is in mixed-display mode  

[Description] 

The program in the disassembled program section cannot be edited if the Source window is in mixed 

display mode. 

[Action] 

This item has been included in the SM78K Series V2.52 user’s manual as a caution on use. 

 

No.32  Files with the same name cannot be displayed in Source window 

[Description] 

The source file in the folder set in the source path under [Option] → [Debugger Option] is opened by 

priority in the Source window. 

C:\TEST\TEST.C ← Source file of C:\TEST\TEST.LMF 

C:\TEST\TEST.LMF 

 

D:\TEST\TEST.C ← Source file of D:\TEST\TEST.LMF 

D:\TEST\TEST.LMF 

 

C:\TEST\ is set in the source path under [Option] → [Debugger Option]. 
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At this time, C:\TEST\TEST.LMF is displayed even if D:\TEST\TEST.LMF is opened from [File] → 

[Download]. 

[Action] 

This item has been included in the SM78K Series V2.52 user’s manual as a caution on use. 

 

No.33  Dummy RRM is disabled in SFR area 

[Description] 

Dummy RRM (real-time RAM monitor function) is disabled in the SFR area and in the SFR area. 

[Action] 

This bug has been corrected in V2.52. 

 

No.39  Asterisk (*) indicating break-settable line is not displayed in Source window 

[Description] 

An asterisk (*) indicating a break-settable line is not displayed in the Source window when only a macro 

(instruction) reference line is described in an include file and the line number is the same as the 

instruction start line number in the file to be included. 

[Action] 

This bug has been corrected in V2.52. 

 

No.47  Bug in saving a display file in Watch window 

[Description] 

If data is added to the Watch window by specifying the address, the data cannot be saved correctly 

even if the display file saving command is executed. 

[Action] 

This item has been included in the SM78K Series V2.52 user’s manual as a caution on use. 



SM78K0 V2.52  Operating Precautions (SUD-DT-03-0383-E) 

 9

 

3.4  List of Handling of Restrictions (Simulator Block) 
 

Since the numbers assigned to the restrictions have not been changed, the restriction numbers shown 

below are not consecutive. 
 

Version No. Bugs and Changes/Additions to Specifications 
V2.40 V2.52 

1 The data creation function of the input 0/1 editor and input timing chart is not 
supported. 

× √* 

9 Bug in TAB key operation in Event & Action dialog box × √* 
19 Bug in system menu in I/O Panel window (Windows NT/2000/XP only) × − 
36 Bug in hold time of I/O panel button/key matrix × √ 
37 Illegal interrupt in serial interface CSIA0 (µPD780148 Subseries) × √ 
38 Illegal interrupt in 8-bit timer TMH1 (µPD780114, 780124, 780138, 780148 

Subseries) 
× √ 

39 P14 cannot be used as output port (µPD780103, 780114, 780124, 780138, 
780148 Subseries) 

× √ 

40 Inverted output is not possible in UART6 × √ 
41 Waveform may be distorted when TM34 is used in carrier generator mode × √ 
42 High level is output from pin when UART0 operation is stopped × √ 
43 On-chip pull-up resistor cannot be connected to P4 (µPD780138, 780148 

Subseries) 
× √ 

44 Read-only bit NRZ1 of TMCYC1 register of 8-bit timer TMH1 can be written  
(µPD780114, 780124, 780138, 780148 Subseries) 

× √ 

×: Applicable, √: Not applicable, √*: Included in user’s manual, −: Not relevant 

 
 
3.5  Details of Handling of Restrictions (Simulator Block) 

 

No.1  The data creation function of the input 0/1 editor and input timing chart is not supported 

[Description]  

The data creation function of the input 0/1 editor and input timing chart is not supported.  

[Action]  

This item has been included in the SM78K Series V2.52 user’s manual as a caution on use. 

 

No.9  Bug in TAB key operation in Event & Action dialog box 

[Description]  

The function to jump to the next input field by pressing TAB cannot be used in the Event & Action dialog 

box. 

[Action]  

This item has been included in the SM78K Series V2.52 user’s manual as a caution on use. 
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No.19  Bug in system menu in I/O Panel window (Windows NT/2000/XP only) 

[Description] 

If the simulator is executed in Windows NT, the menu cannot be deleted or recovered using "Display 

Menu" on the system menu in the I/O Panel window. 

[Action]  

This item has been deleted from restrictions because the system menu function is not described in the 

user’s manual. 

 

No.36  Bug in hold time of I/O panel button/key matrix 

[Description] 

When the main clock is changed in the Configuration dialog box after the simulator is activated, the 

hold time of the button/key matrix in the I/O panel cannot be simulated correctly.  The old main clock is 

used for simulation. 

[Action] 

This bug has been corrected in V2.52. 

 

No.37  Illegal interrupt in serial interface CSIA0 (µPD780148 Subseries) 

[Description] 

When using the µPD780148 Subseries, the interrupt INTACSI occurs each time the last byte is 

transmitted in repeat transfer mode of serial interface CSIA0. 

[Action] 

This bug has been corrected in V2.52. 

 

No.38  Illegal interrupt in 8-bit timer TMH1 (µPD780114, 780124, 780138, 780148 Subseries) 

[Description] 

When 8-bit timer H1 of the µPD780114, 780124, 780138, or 780148 Subseries is used in carrier 

generator mode, the interrupt INTTM51 is generated twice. 

[Action] 

This bug has been corrected in V2.52. 

 

No.39  P14 cannot be used as output port (µPD780103, 780114, 780124, 780138, 780148 Subseries) 

[Description] 

P14 cannot be used as an output port in the µPD780103, 780114, 780124, 780138, and 780148 

Subseries. 

[Action] 

This bug has been corrected in V2.52. 

 

No.40  Inverted output is not possible in UART6 

[Description] 

Inverted output is not possible in UART6 even if inverted output is specified for the TXD pin of UART6.  
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[Action] 

This bug has been corrected in V2.52. 

 

No.41  Waveform may be distorted when TM34 is used in carrier generator mode 

[Description] 

When TM34 is used in carrier generator mode, a waveform may be distorted depending on the setting 

value of the operating clock. 

[Action] 

This bug has been corrected in V2.52. 

 

No.42  High level is output from pin when UART0 operation is stopped 

[Description] 

When UART0 operation is stopped, a high level is output from the pin.  As a result, the pin cannot be 

used as a port pin. 

[Action] 

This bug has been corrected in V2.52. 

 

No.43  On-chip pull-up resistor cannot be connected to P4 (µPD780138, 780148 Subseries) 

[Description] 

An on-chip pull-up resistor cannot be connected to port 4 in the µPD780138, 780148 Subseries. 

[Action] 

This bug has been corrected in V2.52. 

 

No.44   Read-only bit NRZ1 of TMCYC1 register of 8-bit timer TMH1 can be written  (µPD780114, 780124, 

780138, 780148 Subseries) 

[Description] 

When using the µPD780114, 780124, 780138, or 780148 Subseries, the read-only bit NRZ1 can be 

written when the TMCYC1 register of the 8-bit timer TMH1 is accessed in byte units. 

[Action] 

This bug has been corrected in V2.52. 

 

4.  CAUTIONS 
 
Cautions on using SM78K0 V2.52 are described below. 

 
4.1  Device File 
 

A device file is necessary to execute the SM78K0.  The device file is not included in the SM78K0.  

Download the device file via ODS (online delivery service). 

NEC Electronics Microprocessor website (URL: http://www.necel.com/micro/index_e.html)  

→ [Development Tools Download] → [DeviceFile] 
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4.2  Supported devices 
 
The SM78K0 does not support some device subseries.  The support status of each subseries is shown 

below. 

 
Subseries Device Database File 

780024 0021,    0022,    0023,    0024 
0021y,   0022y,   0023y,   0024y 
0021as, 0022as,  0023as,  0024as 

s002x.78k 
s002xy.78k 
s002xas.78k 

780034 0031,    0032, 0033,    0034 
0031y,   0032y,   0033y,   0034y 
f0034 
f0034y 
0031as 
0032as 
0033as 
0034as 
f0034as 

s003x.78k 
s003xy.78k 
sf0034.78k 
sf0034y.78k 
s0031as.78k 
s0032as.78k 
s0033as.78k 
s0034as.78k 
sf0034as.78k 

780233 0232, f0233 s023x.78k 
780831 0831y, f0831y s0831y.78k 
780833 0830y  

0832y  
0833y 
0836y  
0837y  
0838y  
f0833y 
f0838y 

s0830y.78k 
s0832y.78k 
s0833y.78k 
s0836y.78k 
s0837y.78k 
s0838y.78k 
sf0833y.78k 
sf0838y.78k 

780964 0921,   0922,   0923,   0924,   f0924 
0961,   0962,   0963,   0964,   f0964 

s092x.78k 
s096x.78k 

780974 0973 
f0974 

s0973.78k 
sf0974.78k 

780988 0982,   0983,   0984,   0986,   0988 
f0988 

s098x.78k 
sf0988.78k 

780338 0316 
0318 
0326 
0328 
0336 
0338 
f0338 

s0316.78k 
s0318.78k 
s0326.78k 
s0328.78k 
s0336.78k 
s0338.78k 
sf0338.78k 

780948 0948,   0949,   f0948,  f0949 s094x.78k 
780078 0076, 0078, f0078  

0076y, 0078y, f0078y 
s007x.78k 
s007xy.78k 

780066 0065,   f0066 s006x.78k 
780354 0343,   0344  

0353,   0354,   f0354 
0343y,  0344y  
0353y,  0354y,  f0354y 

s034x.78k 
s035x.78k 
s034xy.78k 
s035xy.78k 

780103 0101 
f0103 
0102,   0103 

s0101.78k 
sf0103.78k 
s010x.78k 

780114 0111,   0112,   0113,   0114,   f0114 s011x.78k 
780124 0121,   0122,   0123,   0124,   f0124 s012x.78k 
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Subseries Device Database File 
780138 0133 

0134,   f0134 
0136 
0138,   f0138 
0131,   0132 

s0133.78k 
s0134.78k 
s0136.78k 
s0138.78k 
s013x.78k 

780148 0146 
0148,   f0148 
0143,   0144 

s0146.78k 
s0148.78k 
s014x.78k 

780001  0001 s000x.78k 
78002 001 

001b 
001by 
001y 
002 
002b 
002by 
002y 

s001.78k 
s00x.78k 
s00xby.78k 
s001y.78k 
s002.78k 
s002b.78k 
s002by.78k 
s002y.78k 

78014 011b, 011f, 011h, 012a, 
012b, 012f, 012h, 013, 
013f, 013h, 014, 014f, 
014h, 015f, 016f, 018f, 
p014, p018f 
011by, 011fy, 012by, 012fy, 
013fy, 013y, 014fy, 014y, 
015fy, 016fy, 018fy, p014y, 
p018fy 

s01x.78k 
 
 
 
 
s01xy.78k 

78024 023,    024,    p024 s02x.78k 
780208 0204 

0204y 
0205 
0205y 
0206 
0208,   p0208 

s0204.78k 
s0204y.78k 
s0205.78k 
s0205y.78k 
s0206.78k 
s0208.78k 

780208a 0204a 
0205a 

s0204a.78k 
s0205a.78k 

78044 042 
042a 
042b 
042f 
043 
043a 
043b 
043f 
044,    p044 
044a 
044b 
044f 
044h 
045a 
045b 
045f 
045h 
046h 
p048a 
p048b 

s042.78k 
s042a.78k 
s042b.78k 
s042f.78k 
s043.78k 
s043a.78k 
s043b.78k 
s043f.78k 
s044.78k 
s044a.78k 
s044b.78k 
s044f.78k 
s044h.78k 
s045a.78k 
s045b.78k 
s045f.78k 
s045h.78k 
s046h.78k 
s048a.78k 
sp048b.78k 
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Subseries Device Database File 
780058 0053, 0054, 0055, 0056 

0053y, 0054y, 0055y, 0056y 
0058, f0058 
0058y, f0058y 

s005x.78k 
s005xy.78k 
s0058.78k 
s0058y.78k 

78054 052, 053, 054, 055, 056,  
058, f054, p058, p058f 
052y, 053y, 054y, 055y, 056y, 
058y, f054y, p058y, p058fy 
p054 
p054y 

s05x.78k 
 
s05xy.78k 
 
sp054.78k 
sp054y.78k 

78064 0306, 0306a 
0306y, 0306ay 
0308, p0308 
0308y, p0308y 
062, 063, 064b 
062y, 063y, 
064,  p064, p064b 
064y, p064y 

s0306.78k 
s0306y.78k 
s0308.78k 
s0308y.78k 
s06x.78k 
s06xy.78k 
s064.78k 
s064y.78k 

78078 070a 
070ay 
074, 075 
074y,  075y 
076 
076y 
078 
078y 
p078 
p078y 

s070a.78k 
s070ay.78k 
s07x.78k 
s07xy.78k 
s076.78k 
s076y.78k 
s078.78k 
s078y.78k 
sp078.78k 
sp078y.78k 

78083 081 
082 
p083 

s081.78k 
s082.78k 
s083.78k 

78098 094 
095 
096 
098a,   p098a 

s094.78k 
s095.78k 
s096.78k 
s098.78k 

 
4.3  Cautions on Installation 
 

4.3.1  Product ID 
A product ID is required to install SM78K0 V2.52.  The product ID is shown on the medium or medium 

case. 

 

4.3.2  Caution on activating installer 
Insert the CD-ROM of SM78K0 V2.52 in the CD-ROM drive.  The installer is started automatically.  If it 

does not start automatically, execute “setup.exe” in the directory DISK1 under SM78K0 from Windows 

Explorer. 

 

4.3.3  Caution on restarting computer 
Because it may be necessary to restart the computer after installation, terminate all other applications. 
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4.3.4  Caution on authority for installation 

Administrator right is required for installation of SM78K0 V2.52 in Windows NT, Windows 2000, or 

Windows XP. 

 

4.3.5  Caution on installation directory 
Do not install SM78K0 V2.52 in a directory with a name containing a space or a multi-byte character; 

otherwise the development tools may not be correctly executed. 

 
4.3.6  Caution on re-installation 

To re-install SM78K0 V2.52, uninstall the copy of SM78K0 V2.52 already installed.  If this product is 

installed in a different directory without uninstalling the first copy of SM78K0 V2.52, the first copy of 

SM78K0 V2.52 already installed cannot be uninstalled. 

 

4.3.7  Caution on file created at installation 
The following file will be created after SM78K0 V2.52 has been installed.  This file is necessary for 

uninstalling SM78K0 V2.52 and must not be deleted (the installation destination is assumed to be 

C:\NECTools32).  

C: \NECTools32\SETUP\*.* 

 

4.3.8  Caution on help 
The help is supplied in the HTML help format.  If the help does not operate correctly, proceed as 

follows. 

• Install Microsoft Internet Explorer 5.0 or later (IE5.5 SP2 or later recommended)  

 

4.3.9  Caution on font size of help 
The font size of the help menu is affected by the font settings in Internet Explorer.  The display is too 

large in the default size (“Medium”) of Internet Explorer.  Therefore, change the font size to “Smallest” 

in [Fonts] from the [View] menu and restart the help. 

 

4.3.10  Caution on project manager 
The project manager is not supported in SM78K0 V2.52 or later.  Use PM plus.  PM plus is included in 

RA78K0 V3.60 or later, so upgrade to RA78K0 to V3.60 or later.   If the project manager is used with 

SM78K0 V2.52, the following warning is displayed. 

Wf109: project manager cannot be used with the debugger of this version.  Please use PM plus. 

 

4.3.11  Caution on language used in Windows 
SM78K0 V2.52 can be installed in the English Windows environment only. 

If an attempt is made to install SM78K0 V2.52 in an environment other than English Windows, a 

message indicating a file transfer error is displayed and the installation is aborted. 

This situation also occurs if a language other than English is specified as the system language in the 

“Regional Settings Properties” tab. 
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4.4  Cautions Related to SM78K0 (Debugger Block) 
 

4.4.1  Memory window 
The cursor in the ASCII display area does not follow changes in the display address on the memory 

window. 

 
4.4.2  IAR compiler 

The IAR compiler V3.30A or above is supported. 

 

4.4.3  SFR selection dialog box 
When the SFR names in several lines are selected in the SFR Select dialog box, the order of the 

selected SFR names cannot be changed.  As a workaround for this problem, select the lines one by 

one and change the SFR display order. 

 

4.4.4  Watch window 
Up to 10,000 lines can be displayed in the Watch window.  If the number exceeds 10,000, an error 

message will be output. 

 
4.4.5  Number of lines in C source file 

Up to 65535 lines can be supported (displayed) in a C source file.  If the number exceeds 65535, divide 

the source. 

 
4.4.6  Switching application while icon is being dragged  

If an application is switched for any reason while an event icon is being dragged, the icon cannot be 

dropped.  In such a case, release the drag status using the ESC key. 
       

4.5  Cautions Related to SM78K0 (Simulator Block) 
 

4.5.1  Input Timing Chart Editor window, Output Timing Chart Editor window, and Input 0/1 
Editor window (1) 

The Input Timing Chart Editor window, Output Timing Chart Editor window, and Input 0/1 Editor window 

can only be expanded up to a horizontal width of 1040 dots because the buffer size is limited. 

 
4.5.2  Input Timing Chart Editor window and Output Timing Chart Editor window 

If the screen in which ANI pins are displayed at the beginning is set on the input timing chart or output 

timing chart, the pins set as #47 and #48 are not displayed (may or may not be displayed depending on 

the size).  They are correctly displayed if the screen is re-sized. 
 

4.5.3  SFR Event & Action setting window 
Only the representative interrupt name of interrupts having the same vectored interrupt address is 

displayed on the Interrupt drop down list of the SFR Event & Action setting window or output timing 

chart window. 



SM78K0 V2.52  Operating Precautions (SUD-DT-03-0383-E) 

 17

 
4.5.4  Input Timing Chart Editor window, Output Timing Chart Editor window, and Input 0/1 

Editor window (2) 
Do not use the data search function of the Input Timing Chart Editor window, Output Timing Chart 

Editor window, and Input 0/1 editor window because its search performance is poor. 

 
4.5.5  I/O panel window 

Even if a customized component is moved to the I/O panel window, it is displayed at the position before 

it was moved if it is subsequently reloaded by the project file or custom menu of the I/O panel. 

 
4.5.6  Internal interrupt button 

The interrupt name selection list of the internal interrupt button displays only the representative 

interrupt names of the interrupts having the same vector address. 

 
4.5.7  Scroll-bar level gauge of external parts 

If a scroll-bar level gauge is connected to two or more AD pins, and if these pins are re-connected to a 

dial level gauge or vice versa, the array of the level gauges change/overlap. 

 
4.5.8  Buttons of external parts 

The default value of a pin when a button is connected is 0 for both the active-high and active-low 

models.  As a workaround, set Hi → 0 and Lo → 1 using the pull-up/pull-down function of an external 

part. 

 
4.5.9  Level gauge of external parts 

When using Windows 2000, if right mouse button is clicked once to fix the level gage value of the 

external parts, the value is not fixed but a pull-down menu is displayed, but the value will still be set. 
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5. RESTRICTIONS 
 
5.1  List of Restrictions (Debugger Block) 
 

Since the numbers assigned to the restrictions have not been changed, the restriction numbers shown 

below are not consecutive. 
 

Version No. Bugs and Changes/Additions to Specifications 
V2.40 V2.52 

25 Break point cannot be set if a file name that includes a “-“ (minus) or “+” (plus) 
exists in a source file 

× × 

27 Last line is not displayed in Coverage-Efficiency View dialog box (applicable to 
English version only) 

× × 

34 Symbols with the func#var (func: Function name, var: Variable name) format 
cannot be converted into addresses 

× × 

36 Run may not stop × × 
38 Display digit of bit variable and bit field is wrong in Watch window × × 
40 Read-only project file can be overwritten × × 
41 Help does not open in Trace window even if F1 key is pressed × × 
42 Active project cannot be switched correctly in PM − × 
43 Bug in changing file type by inputting "*.hex" × × 
44 Source path cannot be added even if addition is specified by PM plus − × 
45 Bug in redraw × × 
46 Modification of the address of a label to be snapped is not reflected in snapshot 

execution 
× × 

×: Applicable, √: Not applicable, −: Not relevant 

 
5.2  Details of Restrictions (Debugger Block) 
 
No.25 Break point cannot be set if a file name that includes a “-“ (minus) or “+” (plus) exists in a source file 

[Description] 

If a file name that includes a “-“ (minus) or “+” (plus) exists in a source file, a break point cannot be set 

in the debugger.   

 [Workaround] 

Change the file name so that it does not include a “-“ (minus) or “+” (plus). 

 

No.27  Last line is not displayed in Coverage-Efficiency View dialog box 

[Description] 

The last line is not displayed in the Coverage-Efficiency View dialog box. The last line is hidden behind 

the horizontal scroll bar when an item consisting of 21 characters or more is included and the total 

number of items exceeds 12 in the survey list.  (This bug occurs only in the English Windows 

environment.) 
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[Workaround] 

Add one or more dummy items at the end of the list. 

 
No.34  Symbols with the func#var (func: Function name, var: Variable name) format cannot be converted 

into addresses 

[Description] 

Symbols with the func#var (func: Function name, var: Variable name) format cannot be converted into 

addresses. 

[Workaround] 

Only convert var (variable name).  When there is a variable with the same name as a static variable in 

a function, convert the variable when the PC exists in that function. 
 

No.36  Run may not stop  

[Description] 

When [Run] → [Slowmotion] is selected while Go & Go is under execution, the program does not stop 

even if [Run] → [Stop] is selected (or the stop button is clicked). 

[Workaround] 

There is no workaround. 
 

No.38  Display digit of bit variable and bit field is wrong in Watch window 

[Description] 

If both a bit variable and bit field are displayed in the Watch window, the digit is not displayed as 1 digit, 

but as 16 digits (in binary, not 0b1 but 0b0000000000000001).  The contents of data are correct. 

[Workaround] 

There is no workaround. 

 

No.40  Read-only project file can be overwritten 

[Description] 

Project files (*.prj, *pri) can be overwritten depending on the OS even if the file attribute is set to 

Read-only.  In Windows XP, an error is output when attempting to overwrite the file, but the file can be 

overwritten in Windows 2000. 

[Workaround] 

There is no workaround. 

 

No.41  Help does not open in Trace window even if F1 key is pressed 

[Description] 

The Help window is not displayed when the F1 key is pressed while no trace result is displayed, such 

as immediately after activation of the debugger.   This is because the Help window can be opened by 

the F1 key only in the window on which the caret is placed, and the caret cannot be moved if there are 

no trace results. 

[Workaround]  

Open the Help window by selecting [Current Window Help] under the Help menu. 
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No.42  Active project cannot be switched correctly in PM plus 

[Description] 

When both PM plus and the SM are activated and the active project is switched by PM plus, if the 

activated project does not include the project file (.pri) of the debugger, the load module loaded by the 

previous active project is not reset and remains as is. 

[Workaround]  

Select “Execute symbol reset after download” in the Debugger Settings dialog box by selecting 

[Debugger settings…] on the [Tool] menu of PM plus before creating a project. 

 

No.43  Bug in changing file type by inputting "*.hex" 

[Description] 

Even if the display of the extension select area is changed by specifying the file type as "*.hex" in the 

file selection area in a file selection dialog box, the change is not reflected internally. 

[Workaround]  

Specify the file type in the extension select area. 

 

No.44  Source path cannot be added even if addition is specified by PM plus 

[Description] 

When a project is saved in the SM78K0 and then a new source path is added in PM plus, the new 

source path cannot be added to the debugger. 

[Workaround]  

Add the source path manually. 

 

No.45  Bug in redraw 

[Description] 

If the caret is moved when the Memory window or Coverage window is activated, the line on which the 

caret was placed cannot be redrawn normally. 

[Workaround]  

Redraw can be performed by moving the caret to a line on which redraw was not performed. 

 

No.46  Modification of address of a label to be snapped is not reflected in snapshot execution 

[Description] 

When a label is specified for a memory address subject to snap in the Snap Shot dialog box, if the 

address of the registered label is changed in line with a user program modification, the address before 

modification is snapped. 

[Workaround]  

When the address of the registered label is changed, re-register the snap information using the 

Change button. 
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5.3  List of Restrictions (Simulator Block) 
 

Since the numbers assigned to the restrictions have not been changed, the restriction numbers shown 

below are not consecutive. 
 

Version No. Bugs and Changes/Additions to Specifications 
V2.40 V2.52 

2 IIC arbitration function not supported × × 
4 Bit shift detection function of SIO1 (3-wire, with automatic transfer function) not 

supported 
× × 

5 1-bit shift output function of meter controller not supported × × 
6 IEBUS function not supported × × 
7 Oscillation clock selection function by SFR not supported (µPD780973 

Subseries) 
× × 

8 ROM correction function not supported × × 
11 Bug in interrupt × × 
12 Bug in ADCR0, ADCR1 register × × 
13 Time of the timer operating with the subclock may include an error × × 
14 Bug in setting watch timer (µPD780344, 780354 Subseries) × × 
17 Scroll bar is not displayed in I/O Panel window × × 
20 Bug in system menu in I/O Panel window × × 
31 LIN function of UART6 not supported × × 
32 RING-OSC clock not supported × × 
33 Clock monitor not supported × × 
34 Power-on clear not supported × × 
35 Low-voltage detection circuit (LVI) not supported × × 

×: Applicable, √: Not applicable, −: Not relevant 

 
5.4  Details of Restrictions (Simulator Block) 
 
No.2  IIC arbitration function not supported 

[Description]  

The IIC arbitration function is not supported.  

[Workaround]  

There is no workaround.  
 

No.4  Bit shift detection function of SIO1 (3-wire, with automatic transfer function) not supported 

[Description]  

The Bit shift detection function of SIO1 (3-wire, with automatic transfer function) is not supported.  

[Workaround]  

There is no workaround.  
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No.5  1-bit shift output function of meter controller not supported 

[Description]  

The 1-bit shift output function of meter controller is not supported.  

[Workaround]  

There is no workaround.  
 

No.6  IEBUS function not supported 

[Description]  

The IEBUS function is not supported.  

[Workaround]  

There is no workaround.  
 

No.7  Oscillation clock selection function by SFR not supported (µPD780973 Subseries) 

[Description]  

The oscillation clock selection function is not supported.  

[Workaround]  

Set the oscillation clock in the Configuration dialog box.  
 

No.8  ROM correction function not supported 

[Description]  

The ROM correction function is not supported.  

[Workaround]  

There is no workaround.  
 

No.11  Bug in interrupt 

[Description]  

If an interrupt occurs from the interrupt controller peripheral unit when execution of one instruction has 

been completed, the interrupt signal information is not displayed on the timing chart. In addition, if two 

or more non-maskable interrupts having a separate vector address occur at the same time (multiple 

interrupts), only one interrupt can be acknowledged.  

[Workaround]  

There is no workaround.  
 

No.12  Bug in ADCR0, ADCR1 register 

[Description]  

If conversion is completed by ADCTL0 while a read operation is being executed by the instruction of 

the ADCR0 register, the value of ADCR0 should be changed after reading ADCR0 according to the 

specifications.  Actually, however, the updated value is read.  If a write access to the ADCR0 register, a 

write access to the ADM0 register by a command, and a write access to the ADS0 register conflict with 

each other, the write access to the ADCR0 register is enabled if the conversion operation is enabled, 

and an interrupt signal (INTAD) is generated. This bug also applies to the ADS1 register. 
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[Workaround]  

There is no workaround.  
 

No.13  Time of the timer operating with the subclock may include an error 

[Description]  

The time of the timer operating with the subclock may include an error. 

Example: <1> Specification: 500.0 ms, SM: 498.0736 ms 

 <2> Specification: 15.6 ms, SM: 15.5652 ms 

[Workaround]  

There is no workaround.  
 

No.14  Bug in setting watch timer (µPD780344, 780354 Subseries) 

[Description]  

This is a bug in setting the watch timer operating clock in the µPD780344, 780354 Subseries. 

[Workaround]  

When setting the watch timer operating clock to fXT/2 in the µPD780344, 780354 Subseries, set the 

WTS bit of the WTIM register first and then set the WTNM register. 
 

No.17  Scroll bar is not displayed in I/O Panel window 

[Description]  

The scroll bar is not displayed if a component is moved to the edge of the I/O panel in the layout mode 

or if the customized component for the I/O panel is too big to be displayed. 

[Workaround]  

The scroll bar is displayed by re-sizing the I/O Panel window.  
 

No.20  Bug in system menu in I/O Panel window 

[Description]  

If the I/O panel is minimized in the layout mode, it is not restored to its original size even if the icon on 

the taskbar is clicked. 

[Workaround]  

Right-click the icon and select "Restore" from the system menu.  
 

No.31 LIN function of UART6 not supported 

[Description]  

The LIN function of UART6 is not supported.  

[Workaround]  

There is no workaround.  
 

No.32  RING-OSC clock not supported 

[Description]  

The RING-OSC clock is not supported and not supplied with the mounted macro.  Therefore, the 

operation when the RING-OSC clock is selected as a count clock is not guaranteed. 
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[Workaround]  

There is no workaround.  
 

No.33  Clock monitor not supported 

[Description]  

The clock monitor is not supported.  

[Workaround]  

There is no workaround.  
 

No.34  Power-on clear not supported 

[Description]  

Power-on clear is not supported.  

[Workaround]  

There is no workaround.  
 

No.35  Low-voltage detection circuit (LVI) not supported 

[Description]  

The low-voltage detection circuit (LVI) is not supported.  

[Workaround]  

There is no workaround.  
 




